
Creating & Viewing eBooks and Story Books for iPad 
Dan Herlihy 

 
Creating an eBook 
 
There are many approaches to creating an “eBook.” You can create a book in a word 
processing program such as Open Office or Microsoft Word, add images and text then 
save it as a PDF file. Some of the eBook readers listed below allow you to import the file 
into them. Some will read the text aloud, some only allow you to view it, while others 
can play back sound or video files embedded into a PDF document, which can be done 
using Adobe Acrobat Professional. 
 
You can also create a book in a word processing program, save it either as a (Word) 
doc or PDF file, and then convert it to an epub format book using free online tools such 
as those found at www.epubbud.com. The epubbud site allows you to import your files, 
convert them, and then allows you to download them in various formats for the Nook, 
iPad/iPod, and other devices. You can also upload and embed sound files onto any of 
the pages before converting and saving as an epub format book. 
 
If you first save your file as a PDF before converting it to an epub file, the page size, the 
position and format of text and images on the pages will be maintained when opened in 
the various readers. When converting a Word doc to an epub eBook, depending on the 
“eReader” that you open it in, images may get repositioned, text may be forced onto the 
next page and the formatting may change.  
 
Not all eReaders are alike, and unfortunately while text on a page of an epub book that 
was created from a word processing file may look sharper on the device you are 
viewing it on, versus that from a converted PDF document, the page integrity may not 
have held, and the text and images that were originally on one page may end up getting 
split over two pages. 
 
iPad Apps for Creating eBooks 
These apps for the iPad allow you to create eBooks right on the iPad, then import them 
into an eBook reader on your iPad such as iBooks, or export them as a PDF file to open 
in other readers such as vBookz PDF, vBookz, Goodreader, ReaddleDocs and other 
PDF readers.  

• eBook Magic (3.99) create epub and PDF books – export to email or iTunes. 
This app is one of the best apps to create eBooks in both epub and PDF 
format. Very easy to use, import images, add text, many different page 
layouts to choose from. Add pages, then save and export. Books look great 
when opened in iBooks and other book readers.  

• Book Creator for iPad – (4.99 on sale – 6.99) – record sound, import 
images, add text, import video, music from iTunes library, export to iBooks 
from app. Books look great and sound files can play when opened in iBooks. 

• Book Writer (3.99) – import images, video clips, record/import audio, add 
text, export to iBooks, PDF readers, Free Books and other apps. 
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• StoryPatch (2.99) – import images, use programs clip art, add text, export 
book as PDF file or read in program. 

• My Story – Book Maker for Kids - (1.99) – draw, record narration, add text to 
create books, can export directly to iBooks where recorded sound files will 
play. Also open in SpeakText for eBook where text can be read aloud. 

• Picturebook (free) add images, text, export to eMail as PDF 
• Scribble Press (free) – import images, add text, adds page numbers as you 

go, can export directly to iBooks where text can be selected and read aloud. 
Does a good job with page formatting. 

 
Other writing apps: 
 

• Pictello (18.99) – create picture books with text and audio recordings, export 
as PDF to iTunes or email.  

• StoryKit (free) – can export books to computer to print, record sound, import 
your own images, draw 

• SonicPics (2.99) – import images, record sound, creates self running 
slideshow, can export as movie 

• Story Robe – (.99) talking movie story book similar to SonicPics 
 
Pages – ($20.00) – app for Macintosh computers can export files as ePub for iBooks 
 
iBooks Author 
Free from Mac Apps store – http://www.apple.com/mac/ - application for Mac 
Computers (requires Lion OS) to create interactive eBooks. 
 
iBooks Author can: 

- Import video, images, sound files, music, text – can drag and drop in images and 
text into program 

- Add tables, charts 
- Add interactive “Widgets” containing HTML, media, Keynote presentations, 3D 

images, chapter reviews, add shapes, arrows,  
- Set page orientation, colors, etc.  

 
Export to: iBooks (for iPad), PDF, Text file 
 
 
Start by choosing a layout template – or you can 
start with a blank page. 
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Add items such as text, video, images or interactive widgets which 
can contain multiple images for example in one scrolling window on 
the page. 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
Shown above are sample pages. The page on the left contains a sound file that was 
imported. The page on the right contains an interactive “widget” – an image box that you 
can drag and drop multiple images into. Swiping or using arrow keys in the widget scroll 
from image to image within the window.  
 
Creating a Switch Accessible eBook for iPad 
“Scene & Heard” and “Tap Speak Sequence” (found on the iTunes app store) are both 
switch accessible apps for the iPad. Using them you can create a switch accessible 
book with recorded sound, images and text. Scene & Heard can also import and play 
video. 
 
To create a book using Tap Speak Sequence the pages must be an image that you can 
import into the program. Using a screen capture utility it is easy to create the pages in a 
word processing program, then capture the page as a jpeg image. Import the captured 
page “images” into the iPhoto library on the iPad. There you will be able to access them 
when creating what is referred to as a New Sequence – a sequence of pages or scenes 
– in Tap Speak Sequence. Documentation and directions can be found at 
http://conleysolutions.com/wordpress/ on working with images.  
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With Scene & Heard you can create a sequence of pages, add or record sound files, 
import images, or use the camera in the iPad 2 to take pictures. You can also import 
video and have text or symbols displayed on each page. You assemble the pages as 
scenes which you link together, by starting with a new scene, importing an image, give 
the page a name, adding the scene (page) actions such as playing a sound, displaying 
text, etc. saving, creating a new scene. Pages are then linked together by creating a 
hotspot on the page that links to the next page. 
 
Creating an epub Book from Web Pages 
A free Firefox extension called GrabMyBooks allows you to “grab” 
web pages and convert them to epub format on the fly. The 
GrabMyBooks extension is added to the Firefox toolbar where you 
choose the “My book” icon to access the menu – choosing “My 
book” to capture the web page. http://www.grabmybooks.com/ 
These pages can be imported onto the Nook.  
 
 
Sharing and Viewing eBooks 
Shown here is a view of the listing of programs on my iPad that 
can import or export PDF, epub, Daisy or TXT books. To import 
your own book onto an iPad or iPod, into an app that supports 
the file format that you have created it in, first sync the device 
to your computer. Make sure your device is selected on the left 
side menu in iTunes under the Device section.  
 
Select the Apps menu at the top of the screen. Using the right 
scroll bar, scroll down to the bottom of the page until you see 
the File Sharing list of apps.  
 
 
Select the app from the list that you wish to 
import a book into. Choose the Add button, 
search your computer for the file and click 
Open to import it into the list.  
 
Sync your device. The file should now be in the 
program.  
 
 
To import an eBook into iBooks 
iBooks can import PDF and ePub files into the iBooks bookshelf on the iPad. When 
importing PDF files text cannot be selected and spoken (read aloud) as the text on the 
page is viewed more as an image then text by the program. eBooks created with iBooks 
Author can be exported then imported into iBooks via the process described in the 
following paragraph. eBooks created with iBook Creator, Book Creator, Scribble Press 
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or eBook Magic on the iPad can be exported from those apps directly into iBooks, and 
the text can be selected for playback. 
 
 
To import a PDF or epub file into iBook 
open iTunes, choose Books from the menu 
on the upper left, choose File, Add File to 
Library, search for the PDF file and choose 
Open. This will import the file into the 
Books section. When you sync your device 
with the computer the book will be imported 
into iBooks.  
 
 
Readers, eBook Readers and Story Creation apps 
 
A reader or eBook Reader is basically a program that can open and display you file or 
book. Some have text to speech capability, some cannot display images, some can 
open PDF files, while others can only open specific file formats.  
 
As you create your own books and open them in various readers you will notice a big 
discrepancy in how the book looks from program to program. Some programs will keep 
intact the formatting of each page, while opening up the same book in another program 
might display the first 30 lines of the text on page 1, then display the rest of the text on 
the next page completely altering the formatting. Nothing you did wrong, just how that 
particular program handles the file format that you had saved the book in!  
 
eBook and PDF Readers 
 
iBooks (free) – eBook viewer, will play audio that you have embedded when 
creating/converting the ePub file format ebooks, can import ebooks by adding books 
through iTunes menus when connected to computer or Dropbox, can select text in ePub 
format books to be read aloud.  
 
Perfect Reader (free) – imports your own or downloaded PDF files. Reads text aloud 
but in reading mode strips out images. Voice is not a high quality voice.  
 
vBookz (2.99) – can import your own ePub eBooks that are text based only – does not 
import images, ability to change font size, background, text color, reads aloud with high 
quality Acapela voice – male or female, adjust reading speed, does not play embedded 
audio. 
 
vBookz PDF (4.99) – import and reads aloud PDF files highlighting word by word, 
choose male or female voice 
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ezPDFReader (2.99) – opens PDF files and can playback sound files that have been 
embedded using Adobe Acrobat Professional, books can contain images, forms, video, 
audio, does not import ePub format books. 
 
Stanza (free) – eBook viewer – view ePub files, PDF files, no reading voices, doesn’t 
play embedded sound files. ePub books created from websites using GrabMyBooks 
look great. http://www.grabmybooks.com/  
 
Bookster (free) – free children’s books that read aloud – students can record 
themselves reading the text. 
 
Free Books (free) – download over 24,000 public domain books in text format and 
audio books as well. Ability to import your own ebooks (epub) stored on a Dropbox 
account from within the program, books do not read aloud but you are able to change 
the font size to adjust formatting. Imports epub books created using GrabMyBooks. 
 
DocStorm (free) – can open PDF, TXT and epub files, does not playback sound files 
embedded by Adobe Acrobat Professional. It can play back sound files embedded when 
creating an epub book with epubub, but when doing this the page size becomes smaller 
and you cannot resize page. Open website pages that have been downloaded as an 
epub book using the free Firefox extension GrabMyBooks. 
 
Read2Go – (19.99) Daisy formatted books (can’t contain images), reads text 
highlighting word by word, downloaded Bookshare books (need subscription) and also 
books downloaded into the program from public domain sites such as Project 
Guttenberg. Can only import your own books that are in Daisy format. 
 
Voice Reader Text to Speech (1.99) reads aloud PDF files, if images are in document 
strips out any images and formatting from the file when reading, excellent voice. I would 
create text only PDF versions of free eBooks and open in here to have read. Device 
must be connected to the internet for it to read aloud as it creates sound files on the fly.  
 
SpeakText for eBook (free or 16.99 w/out ads) – reads text highlighting sentence at a 
time. Plays back sound files embedded) on the page using Book Creator for the iPad 
app by choosing the speaker icon of that the sound file. Import  PDF, HTML, epub 
formats via File Sharing/Apps in iTunes – add files to App. 
 
eBook Reader (free) – download free classics 
 
GoodReader – Opens eBooks saved as PDF, does not play audio files. 
 
Kindle – requires Amazon account, read purchased Kindle books 
Nook for iPad – requires a Barnes and Noble Account – more than 500,000 free books  
 
Audiobooks (free) – download and listen to over 3,5000 free Project Guttenberg audio 
books. 

Dan Herlihy      dherlihy@juno.com    www.connectivetechnologysolutions.com        6 

http://www.grabmybooks.com/


Other Solutions & Options 
 
Adobe Acrobat Reader – the free Adobe Acrobat Reader for Mac & PC will read aloud 
text in a PDF document by choosing the View menu, Read Out Loud, then choose 
Activate Read Out Loud. You can choose which installed voice on your computer to use 
for reading. 
 
Read and Write Web App www.texthelp.com – reads files, highlighting word by word, 
that can be opened in a web browser on the iPad. 
 
Converting a PDF to MOBI format for Kindle - http://www.pdftokindle.com/  
 
Importing any eBook onto a Kindle – converting from epub to MOBI format 
http://www.thehowtosource.com/2011/07/09/put-any-ebook-onto-your-kindle/  
 
Saving web pages as an epub file which can be opened in many of the readers listed 
above as well as importing onto a Nook. http://www.grabmybooks.com/ - free Firefox 
browser extension.  
 
Higher end eBook creation for iPad online – 1.99 per book http://www.blurb.com/  
 
Free online eBook converter – convert PDF files to multiple book formats  

http://ebook.online-convert.com/convert-to-epub  
 
eBook Reader 

Name 
Read Text Play Audio Play Video File formats 

Accepted 
iBooks X X X iBooks Author, 

ePub, PDF 
Perfect Reader X   PDF 

vBookz X   PDF 
vBookz PDF X   PDF 

ezPDFReader  X  PDF 
Stanza    ePub, PDF 

Bookster  X  downloads 
Free Books  X  downloads 
DocStorm  X  PDF, TXT, 

ePub 
Read2Go X   Daisy 

Voice Reader 
Text to Speech 

X   TXT, PDF 

SpeakText for 
eBook 

X   PDF, HTML, 
ePub 

eBook Reader    ePub 
GoodReader    PDF 
Audiobooks  X  downloads 
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Creating an ebook 
Using Adobe Acrobat Professional to Attach Sound Files to Text 

 
Dan Herlihy 

 
1. Create the file in a word processing program such as MS Word. 

a. Add images, layout the pages 
2. Save the file as a PDF file. 
3. Using a sound recording application such as Audacity 

(http://audacity.sourceforge.net/) record and save MP3 or WAV files for each 
block of text. 

a. This can be for each line, a sentence if it is isolated on the page as 
opposed to inside a paragraph, or a paragraph. 

 

4. Open the PDF file created in Acrobat 
Professional. 

5. Choose the Tools menu, Advanced Editing, 
Sound Tool. 

 

 

6. Draw a box around, or to the left of the text that you wish to attach a sound file to. 

Which you choose to do depends on the reader you will use. For example the 
ezPDF Reader iPad app will display a sound icon in the box you create to the 
left. Taping it will open the sound playback bar. For other readers drawing a box 
around the text might better indicate for the user that tapping it would play back 
sound.   
 

7. In the window that opens after drawing the box 
choose the Browse button, search your computer, 
select your recorded sound file and click Select. 

 

 

 

Dan Herlihy      dherlihy@juno.com    www.connectivetechnologysolutions.com        8 

http://audacity.sourceforge.net/


8. In the drop down menu next to Content 
Type choose the type of file you have 
attached, click OK. 

 

 

9. The red border in the two images below shows that the file has been attached to 
the document. Double clicking on it will play the file. 
 
 

 
10. To hide the border around the text choose the Select 

Object Tool from the Tools menu and double click on the 
text you have attached the sound file to. The Multimedia 
Properties window opens. Choose the Appearance tab 
and in the Border drop down list choose Invisible 
Rectangle, click Close. 
 
 
 
 

11. When you save the file there will 
not be a visible border around the 
text cueing that there is a sound file attached, but the sound file will play when 
the text is double clicked on.  

 

This file could now be opened in the free version of Adobe Acrobat Reader on a Mac or 
PC. The sound files will play when the text is double clicked on. If you import the file into 
an iPad app such as “ezPDF Reader for iPad” ($2.99) the embedded sound files will 
play when tapped on.  
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Using CAST Book Builder Http://bookbuilder.cast.org
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The CAST Book Builder is a free online program that allows you to create eBooks that 
can be accessed on the web, downloaded and opened on a computer in a web browser 
– you are not required to be online as the browser is only opening the file – printed, and 
also saved as a PDF file from your web browser. PDF files can be imported into iBooks 
on an iPad. 
 
You can import images, text import or record sound files. Books download as a HTML 
file or printed. Books containing images and sound cannot be created from an iPad, but 
text can be added and finished on a computer later.  
 

 
 
 
 

        Add images, text, import or record audio.  
 

 
View online or 
download and open 
in any web browser.  
 
Recorded or 
imported sounds 
will play.  
 
Use Tab and Enter 
commands for 
switch access. 
 
 

http://bookbuilder.cast.org/


How It Works
Zinepal creates eBooks in the PDF, ePub, Kindle and Mobipocket formats. It's one of the easiest ways to make eBooks and
printable PDFs from existing web content in order to reach additional audiences and offer readers more choices.

Step by Step

Start on the Create Yours page by entering the address of a
web page, blog or feed that you want to include in your
eBook.

If you enter the address of a single web page, then Zinepal
adds the page to your eBook.

If you enter a blog or feed, then Zinepal displays a list of
stories. Select the checkbox next to a story to add it to your
eBook.

When you are done, click the "Preview Your eBook" button at
the top of the page. Zinepal then creates a preview of your
eBook.

If you are happy, click on "Finalize eBook" to create your
eBook in PDF, ePub and Kindle/Mobipocket formats.

If you want to edit the contents or change the formatting of
your eBook, then click on "Customize eBook".

Before you finalize your eBook you can also select the
regular delivery option. Use this to regularly receive updated
eBooks with new stories from the blogs and feeds you

How It Works



 http://dotepub.com 
A push-button cloud-based e-book maker - Convert any webpage into an e-book 

Installation 

Check or uncheck the following settings: 

Format: EPUB  MOBI (Kindle) 

Immersive mode 

In the immersive mode, links will be removed, you will not be offered the possibility of keeping 
images and there will be no indication where removed images and videos were. 

And then drag the dotEPUB logo to your browser’s bookmarks toolbar. And that’s it! 

(If your browser doesn’t support drag & drop, try manual installation.) 

Visit an article webpage you want to save or transfer to your e-reader as an e-book. Just press the 
dotEPUB bookmark in your browser’s toolbar. To get better results, use the print version of the 
webpage (visit the FAQ page for more answers). 

Extensions for: Google Chrome, Mozilla Firefox 

dotEPUB is software in the cloud that allows you to convert any webpage into an e-book. 

For content consumers (readers), we have developed a bookmarklet for modern browsers 
(desktop or mobile). And, if you are a Chrome or Firefox user, you can install the dotEPUB 
extension in your browser. For content producers (editors, authors), we offer Creator and a 
widget. Creator lets you make an e-book from a text of your own. The widget helps your users 
getting the content of your website in e-book form (see the tips for webmasters). 

Features 

Download webpages to any epub-compatible device: e-readers, tablets, smartphones, netbooks, 
desktop computers... 

http://dotepub.com/?show=manual&lang=en#manual
http://dotepub.com/faqs/?lang=en
http://dotepub.com/creator/?lang=en
http://dotepub.com/widget/?lang=en
http://dotepub.com/tips/?lang=en
http://en.wikipedia.org/wiki/List_of_e-book_readers

